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LATEX zu benutzen ist das eine, dafür gibt es bereits hervorragende Einfüh-
rungen. Was aber wird für die Installation eines LATEX-Systems unter Windows
benötigt? Was mache ich mit MiKTEX, wozu brauche ich Ghostscript, was ist
Texmaker, und warum schwören viele auf Emacs und vor allem wie paßt alles
zusammen? Diese Informationen muß man sich meist aus vielen verschiedenen
Quellen zusammensuchen, und manchmal scheint manches nicht zusammen-
zupassen, während man vielleicht nur an der falschen Stelle gesucht hat.

Diese Anleitung soll die Suche ersparen und zeigt Schritt für Schritt, was man
alles braucht und wie man die einzelnen Komponenten einrichtet und benutzt.

Wenn Ihnen diese Anleitung gefällt, hilft Ihnen bestimmt auch mein Buch
»Wissenschaftliche Arbeiten schreiben mit LATEX«, jetzt in der 2., überarbei-
teten Auflage erschienen im mitp-Verlag, ISBN 978-3826659355.

Ich freue mich über Anregungen und Hinweise auf eventuelle Fehler. Bei entsprechen-
den meldungen bitte die Versionsnummer mit angeben:
Revision: 1529 Date: 2009-06-12 22:22:28 +0200 (Fr, 12 Jun 2009)

Danke an aufmerksame Leser für viele Anmerkungen und Korrekturen.
Dieses Dokument existiert sowohl in HTML als auch in PDF 1.51. Die korrekten URL

lauten:

• http://schlosser.info/downloads/latexsystem.pdf für die PDF-Version und

• http://schlosser.info/latexsystem für die HTML-Seite.

Eine englische Fassung ist verfügbar:
http://schlosser.info/latexsystem-en

1Adobe Reader 6.0 oder neuer oder Ghostscript/GSview erforderlich.
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1 Intention

LATEX ist kein Programm, sondern eine Sprache bzw. eine Methode der Dokumentbeschrei-
bung und wird benutzt in Form eines LATEX-Systems. Damit lassen sich nicht nur wissen-
schaftliche Arbeiten verfassen, sondern auch hervorragende Briefe, Präsentationen und
vieles mehr.

Für diejenigen, die bisher nicht mit freier Software gearbeitet haben, ist es anfangs be-
fremdlich, selbst verschiedene Komponenten zu einem System zu integrieren, so daß sich
manche vielleicht nicht so einfach hintrauen. Deswegen stelle ich hier meine Umgebung
vor, mit der ich aus LATEX sowohl Postscript und PDF als auch HTML erzeuge.

Dies ist keine Einführung in LATEX, dafür gibt es bereits hervorragende Angebote so-
wohl im Netz als auch in Buchform. Zum Einstieg bis zum kompletten Ergebnis eignet
sich mein Buch2 oder als kurzer Reinschmecker auch die LATEX 2ε-Kurzbeschreibung, die
zum einen bei jeder LATEX-Distribution dabei ist in <texmf>/doc/guides/lshort-german/,
oder von CTAN.org3 heruntergeladen werden kann. Unbedingt empfehlenswert ist auch
die De-TeX-FAQ4, zu beziehen vom Dante-Server5, außerdem l2tabu, das veraltete Befehle
und Pakete und ihre Alternativen aufzeigt. Nicht zu vergessen ist die Dokumentation von

2Schlosser, Joachim: Wissenschaftliche Arbeiten schreiben mit LaTeX. 2. Auflage. mitp Verlag, Juli 2008, ISBN
978–3826659355.

3CTAN ist die Abkürzung für Comprehensive TeX Archive Network, der vollständigsten Sammlung von TEX-
bezogener Software.

4Raichle, Bernd/Niepraschk, Rolf/Hafner, Thomas: Fragen und Antworten (FAQ) über das Textsatzsystem
TEX und DANTE, Deutschsprachige Anwendervereinigung TEX e.V. DANTE e.V. http://www.dante.de/
faq/de-tex-faq/.

5Dante: Deutschsprachige Anwendervereinigung TeX e. V.
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2 Überblick über die verwendeten Softwarepakete

KOMA-Skript, einer in Europa verbreiteten Makrobibliothek und die darüber hinaus Ant-
worten auf viele typographische Fragen bereit hält. Er ist zu finden in jeder besseren LATEX-
Distribution unter <texmf>/doc/latex/koma-script/.

Wer mit der Installation trotz der Anleitung nicht zurecht kommt oder eine sonstige Fra-
ge zum Thema LATEX hat, der schreibe nicht gleich mir persönlich, sondern suche zunächst
im Web und in der FAQ und wende sich bei anhaltender Unklarheit an die Newsgruppe
de.comp.text.tex6. Dort können die meisten Fragen beantwortet werden; und auch zum The-
ma Installation unter Windows antworte ich dort viel lieber als per Mail, weil zum einen
die Antworten dann allen zur Verfügung stehen und außerdem dort viele kompetentere
Anwender und Entwickler mitlesen.

Letzte wichtige Anmerkung: Diese Anleitung ersetzt nicht die Originaldokumentationen
der einzelnen Programme und Bausteine7. Bei Fehlern tut man gut daran, die Dokumen-
tation des jeweiligen Programms zur Hilfe zu nehmen. Die Anleitung bezieht sich aus-
schließlich auf die hier angegebenen Programme. So sind z. B. die Abschnitte über Emacs
und Aufsätze nicht ohne weiteres auf XEmacs übertragbar. Neuere Versionen der Program-
me stellen in der Regel kein Problem dar (ohne Gewähr).

2 Überblick über die verwendeten Softwarepakete

Um vernünftig arbeiten zu können, benötigt man neben der eigentlichen TEX Distribution
verschiedene Komponenten. Eine Zusammenfassung aller bei mir installierten Programm-
pakete und deren Versionen findet sich im Abschnitt 2.5.

2.1 LATEX Distribution: MiKTEX

Die LATEX-Distribution ist der Kern des Systems. Sie beinhaltet die wichtigsten Programme,
die zum Erzeugen von DVI, Postscript und PDF notwendig sind, außerdem alle Zusatzpa-
kete, die erweiterte Möglichkeiten wie z. B. Musiksatz, Standardlayouts für verschiedene
Organisationen, Layoutbesonderheiten u. ä. bieten.

Ich verwende MiKTEX 2.7. Diese Distribution ist meines Erachtens nach sehr einfach zu
installieren, funktioniert prächtig und wird gut gepflegt. Je nach gewünschtem Umfang
sind 30 bis 500 MB herunterzuladen. Alternativ kann man eine – jedoch nicht immer ganz
aktuelle – CD bestellen.

2.2 Editor

Die Distribution ist nur dafür verantwortlich, aus der Eingabe die Ausgabe zu generieren.
Die Eingabe selbst nimmt man im Editor seiner Wahl vor. Die Wahl fällt bei mir auf GNU
EMACS. Daneben möchte ich auch TEXMAKER ansprechen.

6Suchen kann man anstatt mit einem Newsclient wie Thunderbird wunderbar auch mit dem Webinterface
auf http://groups.google.de/group/de.comp.text.tex

7Siehe dazu auch meinen Beitrag in de.comp.text.tex
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2 Überblick über die verwendeten Softwarepakete

2.2.1 Texmaker

Damit der LATEX-Einstieg nicht zu schwer fällt, empfehle ich abweichend von meiner Kon-
figuration als Editor den TEXMAKER8.

TEXMAKER ist für mausorientierte Benutzer der angehmere der beiden hier vorgestell-
ten LATEX-Editoren. TEXMAKER ist gut gepflegt und komfortabel zu nutzen, da er der ne-
ben graphischen Menüs für die meisten mathematischen Symbole und sonstigen wichtigen
Befehle auch während des Tippens von Befehlen mögliche Vervollständigungen als soge-
nannte »Tooltips« ausgibt. Vordefinierte Ausgabeprofile und vieles mehr machen ihn zu
einem durchaus brauchbaren Werkzeug. TEXMAKER ist gerade für den Neuling in LATEX
geeignet, der EMACS noch nicht kennt. Schließlich reicht es für den Anfang völlig aus, ein
Konzept lernen zu müssen. Später können Sie dann auf das Profigerät EMACS umsteigen.

Dennoch sei hier betont, daß TEXMAKER sehr vieles missen läßt, was bei EMACS selbst-
verständlich ist, wie z. B. eine Numerierung in der Gliederungsansicht oder eine leistungs-
fähige Behandlung von Marken (Labels) und Literaturzitaten. Auch die integrierte Recht-
schreibprüfung hat bei weitem nicht die Qualität, wie sie ISPELL/ASPELL für EMACS bie-
ten.

2.2.2 Emacs + RefTeX + AUCTeX + Ispell

Wer unter Unix bereits mit LATEX gearbeitet hat, benutzt eventuell den EMACS, einen Editor,
der eines der mächtigstem GNU Programme ist.

Ich habe mich nicht allein wegen des Editors zum Umstieg auf den EMACS entschieden,
sondern wegen der Zusätze AUCTEX und REFTEX. AUCTEX bietet für alle häufig be-
nutzten Konstrukte aus LATEX Tastaturkürzel an, die das Arbeiten erheblich beschleunigen.
REFTEX läßt den Benutzer beim Einfügen von Querverweisen aus einer Liste aller verfüg-
baren auswählen und hilft beim Erstellen der entsprechenden Marken. Auch das Einfügen
von Literaturzitaten geht mit REFTEX wesentlich schneller und einfacher.

Es bietet sich auf jeden Fall an, die Einführungen zu EMACS und AUCTEX zu lesen und
sich von www.refcards.com die EMACS Referenzkarte zu holen. Der anfängliche Lernauf-
wand lohnt sich, wird er doch bald mehr als aufgewogen durch ein schnelles, effizientes
Arbeiten.

Auch auf eine Rechtschreibprüfung muß man nicht verzichten in EMACS. Sie heißt IS-
PELL und ist hervorragend in den Editor integriert. Eine für Windows portierte Version, die
ich zur einfacheren Verwendung mit einer Installationsroutine versehen habe, stelle ich auf
meiner Homepage9 zur Verfügung. Sie enthält Wörterbücher für Englisch und Deutsch.
Weitere Wörterbücher, z. B. für die neue deutsche Rechtschreibung10, Französisch, Italie-
nisch, u. v. m., finden sich im Netz.

Als letzten Zusatz verwende ich das WYSIWYG11-Plugin PREVIEW-LATEX, welches die
Formeln, Graphiken und Tabellen als Vorschau in etwa so anzeigt, wie sie später im Do-
kument erscheinen werden. Somit wird das Beste aus den beiden Welten WYSIWYG und

8Bislang stand hier TEXNICCENTER. Aufgrund der anscheinend eingstellten Entwicklung und der besseren
Stabilität von TEXMAKER habe ich mich für einen Wechsel entschieden.

9http://schlosser.info/latex
10die ich übrigens ablehne; siehe dazu auch meinen entsprechenden Artikel http://schlosser.info/kultur
11Abkürzung für »What-you-see-is-what-you-get«: Man sieht bereits beim Bearbeiten das Dokument oder

Teile davon in einer Form, die in etwa dem späteren Ergebnis entspricht.
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2 Überblick über die verwendeten Softwarepakete

Offlinebearbeitung vereint12. Formeln beispielsweise werden in der mächtigen LATEX-Syn-
tax eingegeben und gleich nach der Eingabe als Vorschau angezeigt, so daß man sich in
seinem Dokument leichter orientieren und besser querlesen kann, ohne in einem zweiten
Fenster immer eine übersetzte Version des Dokuments öffnen zu müssen. Für die Installati-
on von PREVIEW-LATEX wird neben GHOSTSCRIPT eine Shell-Umgebung benötigt. Hierfür
ist MSYS aus dem Minimalist GNU for Windows-Projekt (MinGW) bestens geeignet.

EMACS bietet unter anderem eine Buttonleiste und ist vollständig über Menüs konfigu-
rierbar, dazu kommt eine ausgezeichnete Hilfefunktion (in Englisch).

2.3 Graphiken in Postscript mit Ghostscript

Für Unix-Kenner ist es selbstverständlich, für Windowsbenutzer anfangs ungewohnt: Die
Benutzung von Postscript als Austauschformat für Vektorgraphiken aller Art. So ist es
auch unter LATEX am besten, Graphiken als (Encapsulated) Postscript (PS/EPS) einzubin-
den.

Aus allen Windowsanwendungen mit ihren Dateiformaten wie z. B. existierende Word-
oder PowerPoint-Zeichnungen, Bitmaps oder Vektorformaten wie CorelDraw läßt sich
problemlos Postscript erzeugen, auch wenn die jeweilige Anwendung dies nicht direkt
unterstützt. Möglich wird dies durch Drucken in eine Datei über einen Postscript Drucker-
treiber, und zwar mit dem Treiber für den Apple Color LaserWriter 12/600.

Um später vorliegende Postscriptdateien anzusehen und kleinere Veränderungen vor-
zunehmen, benötigt man GHOSTSCRIPT mit seinem graphischen Frontend GSVIEW.

Mit diesen ersten drei Komponenten läßt sich die primäre Aufgabe von LATEX bereits
perfekt erledigen: Das Erstellen von druckfertigen, perfekt gesetzten Dokumenten.

2.4 HTML-Konvertierung

TEX4HT hat den Vorteil, daß es als Paket in der Distribution MIKTEX enthalten ist13. Wer
allerdings die absolut neueste Version haben möchte, muß und kann sich diese problemlos
nachinstallieren. Im Normalfall ist das unnötig, kann aber dann sinnvoll sein, wenn Sie
nicht warten wollen oder können, bis Neuerungen hier in MIKTEX angekommen sind.

TEX4HT, egal ob mitgelieferte oder selbstinstallierte Version, benötigt zur Graphikkon-
vertierung das Programm IMAGEMAGICK, welches sehr schnell und einfach installiert ist.

2.5 Übersicht

Die angegebenen Paketgrößen beziehen sich auf das Downloadvolumen, nicht auf den für
die Installation benötigten Platz.

12Kastrup, David: Revisiting WYSIWYG paradigms for authoring LaTeX. TUGboat, 23 November 2002 Nr. 1.
13Zur Benutzung siehe die Dokumentation in <texmf>/doc/html/tex4ht.
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3 Installation und Konfiguration

Programm Größe MB Quelle

MiKTEX 50–400 MB http://www.miktex.org
Texmaker 6 MB http://www.xm1math.net/texmaker/
GNU Emacs 39 MB http://www.gnu.org/software/emacs/
AUCTeX 1 MB http://www.gnu.org/software/auctex/
Ispell Win32 1,5 MB http://schlosser.info/latex
Ghostscript 10 MB http://ghostscript.com/releases/
GSview 1,5 MB http://pages.cs.wisc.edu/~ghost/gsview/
TeX4ht 1,5 MB http://www.cse.ohio-state.edu/~gurari/TeX4ht/mn.html
ImageMagick 9,5 MB http://www.imagemagick.org

Σ ca. 455 MB

2.6 Lizenzierungen

Alle in dieser Anleitung genannten Programme und Pakete sind mindestens kostenlos,
meist sogar freie Software14. Die Lizenzen sagen allesamt aus, daß die Verbreitung frei-
gestellt ist. Die meisten erlauben zudem die Veränderung des Quellcodes, einige wenige
verbieten wiederum den kommerziellen Verkauf.

Trotz der prinzipiellen Kostenfreiheit haben Sie natürlich die Möglichkeit, sich bei den
einzelnen Projekten bei Gefallen auch finanziell erkenntlich zu zeigen. Siehe dazu die Web-
seiten der Projekte.

3 Installation und Konfiguration

Mein System läuft auf Windows XP Professional. Einige Zugriffspfade zu bestimmten Sy-
stemeinstellungen können auf Ihrem System geringfügig von den beschriebenen abwei-
chen.

Zugriffspfade bezeichnen Startmenüeinträge, Schaltflächen und Menüeinträge mit den
entsprechenden Namen. �

Für alle zu wählenden Verzeichnisse gilt: Die Verzeichnisnamen sollten keine Leerzeichen
enthalten, da dies ab und an Probleme verursachen kann. Also besser C:\Programme statt
C:\ProgramFiles und besser C:\MyUser statt C:\DokumenteundEinstellungen\MyUser. �

Die Reihenfolge der einzelnen Schritte ist wegen Programmabhängigkeiten unbedingt
einzuhalten. Diese Anleitung ist selbstkonsistent, d. h. alle Verzeichnisse passen zusam-
men. Verwenden Sie ein anderes Verzeichnis für ein Programm, müssen Sie dies in nach-
folgenden Schritten selbst berücksichtigen.

3.1 MiKTEX herunterladen und installieren

Laden Sie sich zunächst von http://www.miktex.org den Webinstaller und rufen diesen
auf. Nun müssen Sie sich Gedanken machen, ob Sie für den Anfang die Variante Basic oder

14Was bekanntlich ein Unterschied zu kostenlos ist: »Free as free speech, not free beer.« Siehe dazu die Seiten
der Free Software Foundation unter http://www.fsf.org.
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3 Installation und Konfiguration

Complete möchten. Wenn Sie breitbandig ans Internet angeschlossen sind, holen Sie sich
am besten Complete, ansonsten eben die kleinere. Einzelne Pakete können hier problemlos
nachgeladen werden, auch automatisch. Alternativ können Sie auch eine mehrmals im Jahr
aktualisierte CD-ROM des Systems bestellen.

Die Installation selbst ist sehr simpel: Einfach so lange auf weiter klicken, bis Sie fertig
sind und allen Vorgaben folgen. Alle Programme können dann direkt von der Komman-
dozeile aufgerufen werden.

Wenn Sie es lieber noch mit ein paar Bilder haben, dann finden Sie für MIKTEX auch eine
bebilderte Anleitung auf15 (nur auf Englisch).

3.2 Graphikerstellung und -konvertiertung

Man beginnt am besten mit dem Postscript Druckertreiber. Dieser wird eingerichtet mit
Start → Einstellungen → Drucker → Neuer Drucker. Als erstes lokaler Drucker wählen und
als Anschluß den FILE-Port, der richtige Treiber ist der Apple Color LaserWriter 12/600. Den
Druckernamen auf »Postscript File« setzen.

Nach der Installation unter Start→ Einstellungen→ Drucker→ Postscript File→ Drucker
→Druckeinstellungen→ Erweitert→Optionen für Dokument→ Postscript-Optionen folgende
Einstellungen vornehmen: Die Felder Postscript-Ausgabeoption auf »Optimale Portabilität«
und TrueType-Downloadoption auf »Umriß« setzen. Das ICM Color Matching muß deaktiviert
werden, um Farbverfälschungen zu vermeiden, und der Print Quality Mode auf »Best« ste-
hen.

Ab sofort kann jede Windowsanwendung Postscriptdateien erzeugen, indem man ein-
fach den neuen Drucker verwendet. Die erzeugte Datei – der man immer die Erweiterung
.ps anstatt des vorgegebenen .prn geben sollte – kann man nun in GSVIEW betrachten und
nach EPS wandeln.

Für die automatische Weiterverarbeitung installiert man GHOSTSCRIPT, zu ziehen von
http://ghostscript.com/releases/. Hier gibt es nichts zu beachten (also Enter bis fer-
tig). Da vielleicht auch der Wunsch besteht, Postscriptdateien zur Kontrolle anzusehen,
spielt man GSVIEW16, das graphische Frontend zu GHOSTSCRIPT ein. Hier kann man bei
der Installation das Verzeichnis ebenfalls auf C:\Programme\Ghostscript setzen, auch als
Programmgruppe kann man die gleiche wie bei GHOSTSCRIPT wählen.

Es ist überaus sinnvoll, GHOSTSCRIPT dem Suchpfad hinzuzufügen. Also wiedereinmal
in Start → Einstellungen → Systemsteuerung → System → Erweitert → Umgebungsvariablen
der Variable PATH das jeweilige Verzeichnis, z. B. C:\Programme\Ghostscript\gs8.54\bin,
durch Semikolon abgetrennt hinzufügen. Wichtig: Keine Leerzeichen vor und nach Einträ- �

gen in der PATH-Variable!
Um sich auf die Dauer die Arbeit zu erleichtern, empfehle ich, einen »EPS-Drucker«

einzurichten und zu verwenden, auch dafür habe ich eine kurze Anleitung im Internet
verfaßt17.

15Schenk, Christian: The MiKTeX Installation Procedure. 2004 http://www.dante.de/help/documentation/
miktex/.

16GSview. http://pages.cs.wisc.edu/~ghost/gsview/.
17Schlosser, Joachim: EPS Writer für Windows. http://schlosser.info/epswriter.
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3 Installation und Konfiguration

3.3 Texmaker einrichten

TEXMAKER, von http://www.xm1math.net/texmaker/ zu beziehen, ist rasch installiert: Wie
bei MIKTEX einfach alle Vorgaben des Installers akzeptieren. Beim ersten Aufruf fragt TEX-
MAKER, ob es sich für die Verwendung mit MIKTEX konfigurieren soll, was man bejaht
und alle weiteren Vorgaben wiederum akzeptiert.

Um deutsprachige Menüs zu erhalten, gibt es von selbiger Website ein Sprachpaket
namens texmaker_de.qm, welches Sie nach dem Download in das Programmverzeichnis
C:\Programme\Texmaker kopieren.

3.4 Emacs einrichten

EMACS ist wohl der mächtigste aller Editoren und erfordert mehrere Schritte zur Installa-
tion, weswegen dies hier durchgegangen werden soll. �

Ein Mangel von Windows muß zunächst vor dem ersten Start behoben werden, nämlich
die Nichtexistenz der Umgebungsvariablen18 HOME. Dazu erstellt man in Start→ Einstellun-
gen→ Systemsteuerung→ System→ Erweitert→Umgebungsvariablen19 einen neuen Eintrag
mit Namen HOME und weist diesem ein beliebiges Verzeichnis zu, in dem man alle individu-
ellen Einstellungen speichern möchte20. Der Name des Verzeichnisses darf kein Leerzeichen
enthalten (siehe Abschnitt 3)!

Für alle Umgebungsvariablen gilt: Möchte man die Umgebungsvariablen nur für den
aktuellen Benutzer anlegen, erstellt man sie in Benutzervariablen. Sollen sie für alle Be-
nutzer gelten, werden sie in Systemvariablen angelegt. Wir benötigen GNU EMACS in
der Version 2.22, welche wir von http://www.de-mirrors.de/gnuftp/emacs/windows/
emacs-22.2-bin-i386.zip herunterladen, sowie AUCTEX als vorkompiliertes Paket,
zu beziehen von http://ftp.gnu.org/pub/gnu/auctex/auctex-11.85-e22.2-msw.zip.
Wir entpacken die EMACS-Archivdatei emacs-22.2-bin-i386.zip in das Programm-
verzeichnis aus (auch Winzip kann das), so daß wir dann ein Verzeichnis wie z. B.
C:\Programme\emacs erhalten. In eben dieses Verzeichnis entpacken wir auch das Ar-
chiv auctex-11.85-e22.2-msw.zip, wobei mindestens eine Datei überschrieben wird. Die
meisten Entpacker fragen vorher nach.

Um EMACS bequemer aufrufen zu können, rufen wir aus dem Unterverzeichnis bin das
Installationsprogramm addpm.exe auf und bestätigen dessen Nachfrage. Dies erzeugt eine
Verknüpfung im Windows-Startmenü.

Damit ist Emacs bereits fertig installiert.

3.4.1 AUCTEX + RefTEX

Die Integration von AUCTEX mit REFTEX muß noch separat aktiviert werden. Dazu star-
tet man EMACS und erzeugt in diesem die Konfigurationsdatei .emacs in seinem HOME-

18Umgebungsvariablen erlauben es, programmunabhängig bestimmte Verzeichnisse oder allgemein Zeichen-
ketten festzulegen, die dann von allen Programmen gelesen werden können.

19Geht übrigens schneller mittels des Tastaturkürzels Windowstaste+Unterbrechen.
20Ich empfehle, ein entsprechendes HOME-Verzeichnis auf einer anderen Partition als C: anzulegen und die

Umgebungsvariable entsprechend zu setzen. Hält man Daten und Einstellungen und Programme getrennt,
kommt man im Ernstfall schneller wieder ohne Datenverlust an ein lauffähiges System.
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3 Installation und Konfiguration

Verzeichnis (UNIX-Kurzname ~) mit C-x C-f ~/.emacs RET21. Dort fügt man folgende Zei-
len hinzu:

(add-hook 'LaTeX-mode-hook 'turn-on-reftex)
(setq reftex-plug-into-AUCTeX t)
(require 'tex-mik)

Dann die Datei speichern mit C-x C-s, Emacs beenden mit C-x C-c, und fertig ist die Instal-
lation. Wenn nun beim Öffnen einer .tex Datei in der Menüleiste die Einträge »Preview«
und »LaTeX« erscheinen, hat die Installation geklappt.

Um die Voransichten schnell und platzsparend generieren zu können, ist die zusätz-
liche Graphikbibliothek LibPNG22 zu installieren. Dazu laden Sie von http://gnuwin32.
sourceforge.net/packages/libpng.htm die Archive »Binaries« und »Dependencies« her-
unter. Aus dem Binary-Archiv mit einem Dateinamen ähnlich libpng-1.2.xx-bin.zip ex-
trahieren Sie die zwei DLLs im Unterverzeichnis bin namens libpng3.dll und libpng12.
dll und plazieren diese in Ihr Verzeichnis C:\Programme\emacs\bin. Genauso verfahren
Sie auch mit dem Archiv libpng-1.2.xx-dep.zip und der darin im Unterverzeichnis bin
enthaltenen DLL zlib1.dll, auch diese muß in das bin-Verzeichnis von EMACS.

Wenn Sie nun im PDF-Modus sind (C-c C-t C-p), können Sie nun Preview-LATEX mittels
C-c C-p C-d aufrufen.

3.4.2 Ispell

ISPELL kann mit Hilfe meiner Distribution23 sehr einfach installiert werden. Das vorge-
gebene Verzeichnis kann getrost übernommen werden. Auch wird das Programm selb-
ständig zum Suchpfad hinzugefügt. Achtung: die Umgebungsvariable HOME muß bereits
existieren.

3.5 Einrichten der Dateitypen

Zur weiteren Vereinfachung erstellen wir einen neuen Dateityp. Zunächst benötigen wir
eine kleine Erweiterung für EMACS, welche es uns erlaubt, weitere Dateien in einem be-
reits laufenden EMACS Fenster zu öffnen. Die Erweiterung heißt EMACSSERV und ist bei
EMACS bereits dabei.

Um die Funktionalität zu aktivieren, fügen Sie der Konfigurationsdatei .emacs am An-
fang folgende Zeile hinzu:

(server-start)

Nun legen wir einen neuen Dateityp an. Dazu öffnen Sie eine Kommandozeile und ge-
ben folgenden Befehl ein24:

21Das Kürzel C-x steht für die Tastenkombination Strg-x, andere Buchstaben äquivalent. Übersetzt also: Strg-
x, Strg-f, » /.emacs« eintippen, Eingabe drücken. Die Zeichen » /« bedeuten, daß die Datei im HOME-
Verzeichnis abgelegt werden soll.

22Roelofs, Greg: LibPng. http://www.libpng.org/pub/png/libpng.html.
23Schlosser, Joachim: Ispell compiled for Windows. http://schlosser.info/latex.
24Ich weiß wohl, dass ein Aufruf von emacsclientw.exe das Kommandozeilenfenster unterdrückte. Leider

erscheint durch einen Bug in der Semaphoreanlage zu einer Fehlermeldung beim ersten Aufruf. Dies ist
zwar auch beim Kommandozeilenaufruf der Fall, stört aber dort sie nicht, weil sie nicht bestätigt werden
muß.
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3 Installation und Konfiguration

ftype Emacs.Document=C:\Programme\emacs\bin\emacsclient.exe -n -a C:\C
Programme\emacs\bin\runemacs.exe "%1"

Sodann können wir diesem Dateityp mehrere Dateiendungen zuweisen. Wir tun dies
für .tex und .ltx mit den Befehlen

assoc .tex=Emacs.Document
assoc .ltx=Emacs.Document

Ab dann führt ein Doppelklick auf eine .tex-Datei zum Aufruf von EMACS, weitere
Dateien werden im selben Programmfenster geöffnet.

TEXMAKER kann diese Einstellung übrigens auch selbst vornehmen, man wird automa-
tisch beim ersten Starten des Programms danach gefragt.

Das assoc-Kommando führe ich zusätzlich auch noch für die Dateinamenserweiterun-
gen .sty, .cls, .lco und .bib aus.

Damit ist EMACS komplett installiert und die Arbeit mit dem leistungsfähigsten Editor
für LATEX kann beginnen.

Dies waren die letzten Schritte, um ein System für das Erzeugen von druckfertigen Do-
kumenten im PDF oder Postscriptformat zu konfigurieren. Wer also kein HTML erzeugen
möchte, der ist hier fertig.

3.6 Neues TeX4ht installieren

TEX4HT ist bei MIKTEX dabei, und wenn man die vollständige Installation wählt, auch be-
reits fertig zum benutzen auf der Platte. Sollte jedoch jemand in der Änderungshistorie von
TEX4HT http://www.cse.ohio-state.edu/~gurari/TeX4ht/bugfixes.html25 Neuerungen
entdecken, die er unbedingt schon einsetzen will, bevor sie auch in MIKTEX erscheinen,
lade er sich von der Homepage das aktualisierte Paket herunter.

Voraussetzung für TEX4HT ist zum einen GHOSTSCRIPT, das bereits im vorigen Ab-
schnitt installiert wurde, sowie IMAGEMAGICK, das wie folgt eingerichtet wird:

Von der IMAGEMAGICK-Website unter Downloads26 das entsprechende Windows-Exe-
cutable herunterladen und installieren. Am einfachsten alles bestätigen, was voreingestellt
ist. Dann ist nämlich das Konvertierungsprogramm bereits in den Suchpfad eingetragen.

Zur Sicherheit sollten zunächst die MIKTEX-Pakete für TEX4HT entfernt werden. Dazu
ruft man den MikTeX-Paketmanager auf (mpm.exe) und deinstalliert die Pakete tex4ht und
miktex-tex4ht-bin. Einfach auswählen und das Minus anklicken.

Jetzt kann man daran gehen, das eigentliche TEX4HT zu installieren. Dazu lädt man von
der TEX4T-Bugfixes-Seite http://www.cse.ohio-state.edu/~gurari/TeX4ht/bugfixes.
html27 das neueste Paket herunter, das einen Namen wie etwa tex4ht-x.y.jjjj_mm_dd_

hhss.tar.gz trägt und entpackt es nach C:\. Normalerweise sollte jedes neuere Packpro-
gramm .tar.gz entpacken können. Nun befindet sich in C:\ ein Verzeichnis mit einem
Namen wie tex4ht-x.y.jjjj_mm_dd_hhss. Dieses Verzeichnis benennt man um in tex4ht. �

Sodann verschiebt man alles, was im Verzeichnis C:\tex4ht\texmf\tex liegt, nach c:
\localtexmf\tex. Eventuell muß man dieses Zielverzeichnis auch erst anlegen.

25Ganz am Ende der Link »Log of modifications«
26ImageMagick Windows Binaries. http://imagemagick.org/script/binary-releases.php#windows.
27Neben der regulären TEX4HT-Distribution gibt es auch ein Paket mit einer für MIKTEX angepaßten Version.

Mit dieser habe ich keine Erfahrung, halte sie auch für überflüssig.
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4 Benutzung

Um nun die neuen Dateien dem TEX-System bekannt zu machen, öffnet man eine Kom-
mandozeile (Start→ Ausführen→ “cmd”) und ruft

initexmf -u

auf.
Dann müssen die ausführbaren Dateien dem Suchpfad hinzugefügt werden. Wie schon

öfters an anderer Stelle ist dazu ein Eintrag in der Umgebungsvariablen PATH zu tätigen.
Also wiedereinmal in Start → Einstellungen → Systemsteuerung → System → Erweitert →
Umgebungsvariablen in der Variable PATH das Verzeichnis C:\tex4ht\bin\win32; vor den
Eintrag für c:\texmf\miktex\bin einfügen, notfalls auch ganz an den Anfang. �

Als letztes ist die Konfigurationsdatei von TEX4HT anzupassen. Dazu öffnet man die
Datei c:\tex4ht\texmf\tex4ht\base\win32\tex4ht.env, sucht die Zeile

tc:\path\tfm!

und ersetzt sie durch folgende28:

tc:\Progra~1\MikTeX~1.7\fonts\tfm!

TEX4HT ist nun installiert und kann benutzt werden. Will man den OPENOFFICE.ORG-
Export von TEX4HT nutzen, muß ein Zip-Packer im System verfügbar sein. Ich verwende
dafür INFO-ZIP29, wobei ich nur die Datei zip.exe in ein Verzeichnis kopiere, welches
ohnehin bereits im Suchpfad enthalten ist. Wird bei der ersten Benutzung von oolatex.bat
festgestellt, daß die erzeugte OPENOFFICE.ORG-Datei fehlerhaft ist, kann dies in der Regel
behoben werden, indem abermals die Datei c:\tex4ht\texmf\tex4ht\base\win32\tex4ht.
env editiert wird und die Marken <oo-alt> und </oo-alt> durch <oo> bzw. </oo> ersetzt
werden und umgekehrt, womit eine alternative Bearbeitung aktiviert wird.

3.7 Installation komplett

Herzlichen Glückwunsch! Auch TEX4HT ist nun installiert und das TEX-System kann alle
wichtigen Ausgaben erzeugen.

Wie sieht es mit einem Export nach Word aus? Es gibt im Prinzip keinen Grund, LATEX
nach Word zu exportieren, trotzdem existieren Programme, die LATEX nach Rich Text For-
mat (.rtf) konvertieren, welches sich dann problemlos in Word öffnen läßt. Als besten
Weg empfinde ich jedoch den Weg über HTML oder OPENOFFICE.ORG. Heißt: LATEX mit-
tels TEX4HT nach HTML oder OPENOFFICE.ORG konvertieren, und dies dann in Word
bzw. OPENOFFICE.ORG öffnen.

4 Benutzung

Die Erzeugung der Ausgaben können in der Regel von den Editoren ausgelöst werden,
dafür gibt es entsprechende Knöpfe und/oder Tastaturkommandos.

Für die Benutzung der EMACS-Zusätze sei auf deren Dokumentationen verwiesen. Mag
der Einstieg auch hart erscheinen, es lohnt sich wirklich.

28TeX4ht kann nur Pfadangaben ohne Leerzeichen verarbeiten
29Info-Zip. http://www.info-zip.org.
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4 Benutzung

4.1 Benutzung von TeX4ht

TEX4HT ist ein flexibles Werkzeug, wenn es darum geht, LATEX nach HTML zu konver-
tieren, jedoch verliert man bei den vielen Optionen anfangs leicht den Überblick. Mit ein
wenig Übung läßt sich jedoch auch hier alles erreichen, was man sich vorstellt.

Die TEX4HT-Dokumentation an sich ist nicht besonders üppig. Eine komplette Aufli-
stung der Optionen, ausgegeben in die Logdatei, erhält man jedoch, wenn man einen Auf-
ruf

htlatex.bat myfile.tex "info"

in der Kommandozeile auf einer beliebigen LATEX-Datei absetzt. Unbedingt htlatex.bat �

aufrufen, nicht einfach htlatex, da sonst ein MikTeX-Programm gestartet wird.
Da ich so klares XHTML und so kleine Dateien wie möglich erhalten möchte, verwende

ich den meist den Aufruf

htlatex.bat myfile.tex "xhtml,2,fn-in,NoFonts,fonts,graphics-,sections+,C
next"

für die Umwandlung. Das erzeugt XHTML, eigene Dateien für zwei Gliederungsebenen,
keine speziellen Schriftenanweisungen, aber prinzipielle Formatierungen, nichtskalierte
Graphiken und hilfreiche Hyperlinks. Wer eine originalgetreuere Wiedergabe der Schriften
haben möchte, läßt die Option NoFonts weg, was natürlich zu ein wenig größeren Dateien
führt. Für eine monolithische Datei wird statt der 2 eine 0 angegeben.

4.2 Graphikumwandlung

Alle Graphiken, die man in einem Dokument verwendet, müssen natürlich irgendwo her-
kommen. Generell rate ich stark davon ab, Diagramme oder Graphiken als Bitmap zu er-
stellen, etwa mit Photoshop oder ähnlichen Programmen. Vielmehr rate ich zu vektorori-
entierten Programmen wie z. B. CorelDraw, OpenOffice.org Draw, Visio oder ähnlichen.
Fast alle Anwendungen wie Excel oder PowerPoint oder MATLAB verarbeiten ihre Gra-
phiken ebenfalls vektororientiert, und erzeugen deshalb mit Hilfe des Apple Druckertrei-
bers hervorragende Postscriptdateien. Diese Postscriptdateien wandelt man dann in EPS
um30.

Die generierte Datei mit der Erweiterung .eps lädt man in GSVIEW, um zu sehen, ob
z. B. noch die Bounding Box angepaßt werden muß. Um in GSVIEW die Bounding Box
anzeigen zu lassen, wählt man Menü Options→ Show Bounding Box.

Sollte die Bounding Box nicht stimmen, so kann mit dem Befehl File→ PS to EPS entwe-
der automatisch oder manuell die Bounding Box festlegen lassen und die Ausgabe in eine
neue Datei speichern. Automatisch kann man dabei wählen, wenn die komplette Graphik
verwendet werden soll. Manuell wird man die Bounding Box nur dann festlegen, wenn
unerwünschte Kopf- oder Fußzeilen abgeschnitten werden sollen. �

Unbedingt beachten: Erstellt man Postscript oder DVI, müssen Bilder im (Encapsulated)
Postscript-Format (EPS) vorliegen, wohingegen beim Verwenden von PDFLATEX hingegen
nur Graphiken verarbeitet werden, die in PDF, JPEG oder PNG vorliegen. Zwar kann man
sowohl dem einen, als auch dem anderen LATEX-Prozessor alle Bildtypen beibringen, muß

30siehe dazu auch Schlosser, Joachim: EPS Writer für Windows. http://schlosser.info/epswriter
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5 Wenn etwas nicht funktioniert

dazu aber spezielle Optionen verwenden, die dann vielleicht nicht portierbar auf andere
Systeme sind. Soll also beides – DVI und PDF – erzeugt werden, müssen die Bilder mei-
stens auch in zwei Formaten vorliegen.

Will man mittels PDFLATEX aus seinen Dokumenten das PDF erzeugen, so müssen die
EPS-Dateien also nach PDF umgewandelt werden. Dazu gibt es den Befehl epstopdf, der
etwa so aussieht:

epstopdf file1.eps

Bitmapdateien wie JPEG oder PNG werden von PDFLATEX direkt gelesen. Nur für den
normalen LATEX-Aufruf müssen sie mit bmeps nach EPS umgewandelt werden .

Graphiken, die man mittels METAPOST erzeugt hat, einer Graphiksprache, die standard-
mäßig bei LATEX dabei ist, können ohne Umwandlung eingebunden werden.

5 Wenn etwas nicht funktioniert

Sollte irgendetwas nicht funktionieren, oder sich offensichtlich seltsam verhalten, ist das
kein Beinbruch. Häufig liegt es an vergessenen Umgebungsvariablen. So sollte zunächst
überprüft werden ob alle von dieser Anleitung geforderten Umgebungsvariablen entspre-
chend gesetzt wurden. Fehlt eine, oder ihr Inhalt ist falsch, dann ist es möglich, daß eine
danach durchgeführte Installation – vor allem von PREVIEW-LATEX – fehlschlug. Also noch-
mal. Außerdem eine beliebte Fehlerquelle: Dateien am falschen Ort. Einfach nochmal nach
Anleitung kontrollieren und ggf. korrigieren.

Gegebenenfalls sollte man dann auch einen Blick in die Installationsanweisung des je-
weiligen Pakets werfen, ob dort noch weitere Hinweise zu finden sind. Denn natürlich
auch nicht auszuschließen ist, daß meine Anleitung einen Fehler enthält. Wenn eigentlich
alles stimmen müßte, am besten unter Angabe der Versionsnummer bei mir nachfragen.
Vielleicht habe ich eine Annahme getroffen, die nicht allgemein statthaft ist, oder eine neue
Version eines Pakets arbeitet anders und dieser Text ist veraltet.

6 Ausblick

Bei all den Möglichkeiten, die einem die Vielzahl der Pakete für LATEX bieten, gilt immer:
nicht in den Spielereien verlieren. Einfache Layouts und Strukturen wählen, insbesondere,
wenn das Dokument auch in HTML publiziert werden soll.

Bei weitem nicht alle Feinheiten der Dokumentenumgebung können in diesem Umfang
erörtert werden. Mit Hilfe dieses Artikels jedoch sollte es jedem einigermaßen mit Win-
dows vertrauten Benutzer möglich sein, relativ rasch mit dem Schreiben und Setzen von
Texten beginnen zu können. Ich selbst habe erst 2002 LATEX für mich entdeckt und möchte
es nicht mehr missen. Jeder wird, wenn er sich erst einmal darauf einläßt, von den Vortei-
len begeistert sein, die es bringt, seine Texte in hoher Qualität setzen zu lassen anstatt sich
über die Unzulänglichkeiten eines Wortprozessors zu ärgern.

Wenn dieses Dokument dazu beiträgt, die Scheu vor der Einrichtung und Nutzung eines
solchen Systems ein wenig zu lindern und somit die Hemmschwelle zum Einstieg in LATEX
herabzusetzen vermag, dann hat es seinen Zweck erfüllt.
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